
 

 

45 Autodesk® Revit® Tips in 45 Minutes  
Chad Smith – KarelCAD, Australia 

AB2462 This class will be a fun and upbeat binge of random Revit platform tips. Everyone loves to 
learn something new, regardless of how small that something is, and even the most veteran of Revit 
users never stop learning. At roughly 1 tip every minute over the course of 45 minutes, I will throw 
enough tips your way so that you can take something away. The tips covered will range from very small 
and simple to some that will require a bit more explanation. While this is primarily a Revit platform class, 
I will also try to put a couple of Revit Architecture, Structure, and MEP tips into the mix. 

 

Learning Objectives 
At the end of this class, you will be able to: 

• Keep enjoying using Revit 

• List at least 5 things you previously didn't know 

• Improve your workflow 

• Show off to your work colleagues by showing them something they didn't know 

 

 

 

 

 

 

 

 

 

About the Speaker 
Chad has been an Autodesk® product user for the past 14 years in the area of building design, 
of which 10 of those years have been using and pushing Autodesk® Revit® to its limits. Having 
recently changed career paths, he now works as a Solutions Integrator with Australia's largest 
Autodesk reseller. As an approved Autodesk instructor, he actively teaches Revit, supports 
Revit users, and gets to share his personal Revit experiences with companies around the 
country who are looking to move into a BIM environment through the application of strategic 
implementation plans.  
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This document is meant to be read in conjunction with the provided recorded video to add more 
detail which isn’t covered here. 

System Hardware (Credit: Anthony Hauck) 
1. The question of what’s the best system hardware for your spend is always a dilemma. The 

answer typically depends on the size of the projects you are working on, but there is a 
generalized order of where you should focus your money specifically for Revit: 

a. More RAM 

b. Faster Processor 

c. More Processors 

d. Faster RAM 

e. Faster HD 

User Interface 

2. Keyboard Shortcuts  
We all know that we can run our regular modeling and documentation tools via keyboard 
shortcuts to improve interaction speeds, but what about also controlling the Revit UI? 
Here are some suggestions; 
 
More available screen space 
F2 – Properties 
F4 – Project Browser 
 
Controlling Windows 
CH – Close Hidden 
TW – Tile Windows 

3. Ribbon Tab Organisation  
You can rearrange the Tabs on the Ribbon by holding down the CTRL key and then 
dragging the Tab to a new location. 
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4. ‘Quick’ Places  
We are able to create new ‘Places’ in the Revit Options which will create shortcut folders in 
the vertical bar when in file dialogs such as the Open, Save and Load Family, but there is a 
quicker means to do so simply by dragging a folder from the list over to the vertical bar. 
 

 

User Input 

5. Chain Selections 
Unlike AutoCAD, Revit doesn’t offer the ability to create ‘polyline’ elements, which means 
that Revit elements aren’t joined end to end to other like elements. But Revit does offer 
some abilities to make the selection process easier. 

a. Full 
Hover the cursor over one element in an end-to-end chain of elements, press the 
TAB button to highlight, and then use the mouse left button to select. 

b. Partial 
Select one element, hover the cursor over another elements in the end-to-end chain 
of elements, press the TAB button to hightlight, and then use the mouse left button to 
select. 
 
TIP: With a closed chain of elements, after the highlight stage if you move the cursor 
from one side of the element which you TABed over, to the other side of the element, 
you can decide which direction (clockwise or counter-clockwise) the highlighting if 
following. 

6. Closing Chains  
When you are drawing out chains of Walls, or Sketch Lines while in Sketch mode, you can 
use a keyboard shortcut to snap back to the start point. The default keyboard shortcut is 
SZ. 
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7. Calculated Vaules  
Revit has a simple built in calculator for when you are entering values. These values can be 
in Temporary Dims, Permanent Dims, Properties or anywhere else a numerical value is 
requested. 
To get Revit to calculate a value, simply put an = at the beginning of the value and then 
type your calculation. E.g. " = 4 * 3650 ” 
 
TIP: You can also use parentheses to control the order of calculation. 
E.g. “ = 4 * (3650 + 85) “ 
 

 

8. ‘Quick’ Copy 
Look closely at the cursor as you hold down the CTRL button you will notice that you get a 
tiny + symbol showing which most users typical associate with adding to a selection of 
elements. But it also has a secondary functionality. 
While holding down the CTRL button and then clicking and dragging an element/s, you can 
create a new instance. This has the obvious limitation of not necessarily being able to place 
the new instances accurately, but it is great for other non-critical elements such as 
Furniture, Plants, or even if you are doing a rapid layout design of a Floor Plan. 
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9. ‘Quick’ Element Alignment 
Before placing an element into the model, if it needs to be aligned to another element try 
hovering it over that other element first and the pressing the Spacebar. 
 

 
                Before using Spacebar   After using Spacebar 
 
TIP: The Spacebar also works after the element has been placed, and will rotate it 
(typically) in 90 degree increments. 

Views / Project Browser 

10. Datum Visibility  
Probably one of the biggest issues which catches new Revit users is when Datum elements 
such as Grids and Levels go missing in other views, namely Elevations. The issue here is 
that the ‘3D Extent’ of the Datum has been withdrawn from the view range of the currently 
open view. What you need to do is use other view to find the Datum’s 3D Extents and pull it 
back into range. 
 
Take the following West Elevation view example. You can see that the Level lines aren’t 
displaying, and this is not because the Visibility settings are turned off. 
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Now if we go to the South Elevation view, we can see that the Level lines have had their 
left extents pulled over to the right. This has removed them from the view range of the West 
Elevation. 

 
To resolve this we have two options. 
 
Either move the left extents of the Level lines back over to the left so they are within the 
view range of the West Elevation. 
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Or, extend the view range of the West Elevation out far enough so that it is now 
overlapping the left extents of the Level lines. 
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11. Elevation Marker Rotation (Credit: Jeff Hanson) 
Ever had an Elevation marker no longer be parallel to an element such as a wall? And no 
matter how much you use the Rotate tool on it, you can never get it back 100% parallel? 

 
There is a simple and rather overlooked solution to this issue, and it revolves around using 
the Rotate symbol on the elevation circle. Simply click and drag it and you will notice that 
the Elevation arrow will once again snap itself to the nearest Wall element. 
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Linking 

12. Master Planning  
When creating a large master plan for an aged care facility with townhouses or possibly a 
couple of large towers for an inner city development, it can sometimes be very difficult to 
gain the PC processing power to interact with such a large number of files at the same 
time. The trick here is to incorporate Worksets into the file linking workflow. 
 
For those that haven’t used Worksets, they form part of the Worksharing workflow and are 
essentially ‘layers’ to allow multiple users restricted access to those Worksets so all users 
can work on the same project simultaneously. That was until Element Borrowing was 
introduced. 
These Worksets can then be turned On or Off, which in essence unloads those elements 
from your system memory, and thereby making the rest of the project run faster. 
 
Fortunately, even if you aren’t using Worksets for the purpose of a multi-user environment, 
you can still take advantage of those system performance increases by turning off 
Worksets for linked files on your Master Plan. 
This can be obtained as simply as activating Worksets on your individual building projecy 
files, and creating two Worksets; Exterior and Interior. Then as you link in your Revit project 
files to your Master Plan, you can use the Specify option on the Open button to select 
which Worksets you want On. 
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13. Host Family on Element in Linked File 
Currently, hosted elements such as Wall Hosted can’t be hosted to elements within a 
Linked file. The way we get around this is to create a Face Hosted element which can now 
be hosted on any element face. 

14. Exporting In-Place families  
Here is a nice little workaround to help save out any In-Place families to your content 
library. 

a. Select the In-Place family and press Edit In-Place. 

b. Select the elements in the family which you want to save out to a Family file. 

c. Group these elements using the Create Group tool. 

d. Go to the Application Menu (‘R’ button) > Save As > Library > Group. 

e. Choose where you want to save the group and press Save. 

f. Your Family is now ready to be loaded into a project. 
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Printing 

15. View not Printing as Expected  
Very rarely does a view or sheet not print 100% as it looks on a screen. This typically 
happens when the ‘Vector Processing’ setting in the Print Setup is used. 
As an alternative, try using the ‘Raster Processing’ setting for that difficult view. So far there 
hasn’t been a view related issue which I haven’t been able to print using this option. 
 

 

Modeling 

16. Floor Set-Downs  
Use Void Families to quickly and easily create set-downs in floors. 

a. Start a new Floor based family. 

b. Model an extrusion, using parameters if you wish to control it 

c. Use the Cut Geometry tool to cut it out of the Floor placeholder element in the family. 
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17. Conical Roofs  

a. Start the Roof by Footprint tool. 

b. Sketch in a circle representing the outline of the roof. 

c. Give the sketch lines a Defines Slope, and set the Slope. 

d. Finish the sketch. 
 

TIP: To give the round sketch lines some segments, select them and set the Number of Full 
Segment parameter to anything other than 0. 
 

 

18. Trim the top of a curved Wall  
With a curved Wall element, the Edit Profile tool is unavailable meaning that you don’t have 
an easy way to modify the top edge so that it is sloped. But depending on the result you are 
after and the accuracy you require, there is a quick and dirty means to achieve this. 
 
Go to a Section or Elevation view and create a Reference Plane at the angle you wish to 
create the slope on the wall. Select the wall and pick Attach Top/Base. Select the 
Reference Plane. 
The wall will attach to the Reference Plane and will remain attached to it. 
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19. Custom Curtain Walls 
Users love to use Curtain Walls, especially as a replacement to creating Window families. 
The argument for whether this is right or wrong we’ll leave for another day. 
There is no doubt that using the automatic pattering and mullion placement parameters in 
the Type Properties saves users time and effort. But these rules create pattern which are 
limited and inflexible. Why not create your own rules with Curtain Walls. 

a. Start by modeling in the Curtain Wall and make it look as you want. 

b. Then use the Dimension tool to constrain parts of the Curtain Wall. 

c. Delete the Dimensions, but keep the constraints intact. 
 

 
TIP: You can create a library of Curtain Wall ‘parts’ for different constrained combinations 
and then save them into a project file for later use. 
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20. Stair Tread Brackets  
You can’t create a stair tread bracket and assign it to a Stair element as a parameter. But 
you can use a Railing element to help fake the placement of a bracket at every tread. This 
is achieved by the fact that you can create a Baluster Family which you can assign to each 
tread for the stairs. 
So for this example, there are two elements; first the Stairs which defines nothing more 
than the stair treads, and secondly a Railing element which defines both the center stringer 
support and the tread brackets. 
 

 
 
 

  



45 Autodesk® Revit® Tips in 45 Minutes 

16 
 

21. ‘Quick’ Filter  
Select an element (or Part) and go into Filters and create a New filter. Revit will 
automatically start filtering based on the selected elements. 
 

 

  



45 Autodesk® Revit® Tips in 45 Minutes 

17 
 

Parts 

22. Demolish Finish Layers of Walls 
Using the new Parts tools, look at the part’s instance properties and override the Phasing. 
 

 

23. Wall Layer Function Visibility  
For the longest time users haven’t been able to completely control the Finishes on their 
Walls separately to the Structure of the Wall. With the introduction of Parts for construction 
modeling, this is now a reality but it not the most obvious at first glance. 
 
For this to work we need to first look at the difference in categorization between the Walls 
and Parts. Even though the term Parts is used to identify a sub-element of an overall 
element, the categorization of that Part is ‘Parts’ and not ‘Walls’. 
 
With this clarification, you can now create a Filter which is assigned to the Parts category, 
and then Filtered by Construction which equals Finish. 
The Filter can then be assigned to a View’s Visibility Graphics Overrides and turned off. 
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TIP: As an alternative you can also filter by other useful data such as Material. 
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Phasing 

24. Demolished Door Opening  
When you Demolish a Door or Window, Revit will automatically infill the opening. You can 
select the infill, but you cannot delete it without deleting the entire Door. 
But if you assign a value to the Comment field for the infill, you now have data which you 
can use to filter the infill out of the view through the Visibility/Graphic Overrides > Filters.  
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Documentation 

25. Roofline Over 
Outlines of rooflines over can be shown without having to resort to drawing ‘dumb’ lines. 

a. On a lower plan view, set the Underlay parameter to a level which has a roof on it. 

b. Use the Linework tool on the Modify tab. 

c. Set the Line Style, typically <Overhead>. 

d. Pick the edges of the roof lines. 

e. Set the Underlay parameter back to None.  
 

 
 

  

1 

2 
3 

4 
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26. Scheduling & Tagging Nested Families 
When you nest a family inside another, and you want those nested families to be able to be 
schedule or tagged, the default family parameter settings won’t allow you to do this. 
 
To achieve the desired result, before you nest a family inside another you need to make 
sure that in the nested family that the family parameter ‘Shared’ is checked. This will 
‘expose’ the nested family to the project allowing it to be scheduled and tagged. 
 

 

27. Spot Slope on Ramps  
Currently it is impossible to place a Spot Slope tag directly to a Ramp element. As a 
workaround, it is possible to tag the Ramp in a 3D view which is viewed from a Top 
orientation, and then Cut the tag from the view and then Paste it in the Floor Plan view. 

 

28. White on Black  
If you’ve ever tried putting a White colour against a Black background, you’ve probably 
noticed that Revit will convert that White back to Black. 
As a workaround, set the Red, Green, Blue (RGB) colour to something like 255,255,254 
which is only one point away from being true white. The different in colour is 
indistinguishable. 
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29. Indicative Graphical Floor Finishes  
Using the Color Scheme parameter for views is great for colour coding a floor plan, but it 
can also be used to quickly represent indicative floor finishes. 
 
Using the same principle, create a Color Scheme based on Floor Finish, and then set a Fill 
Pattern which will graphically indicate your desire floor finishes. This will allow you to 
quickly change the Floor Finish parameter of a Room to update the graphical floor finish. 
 

 
 

30. Depth of Elevation 
Creating a feel of depth in Elevations has always been challenging, but with the new 
Ghosting ability in 2012, here’s my take on an old problem. 

a. Create a Mass family which contains a cube. You can use the Box Mass family 
which comes with Revit as a starting point. 

b. In this family, create three materials which are white and set each of the materials 
Transparency values differently. 
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c. Create three Family Types. 

d. Create a Material parameter, and then assign each of the materials in each Type. 
You will also have to make sure your Material parameter is associated with the cube 
geometry. 

e. Load the Mass family into your project and place them in the areas where you want 
to help give the sense of depth. You can see in the image below that the Mass with 
only 25% transparency is on the inner, while the Mass with 50% is further to the 
outside. 
 

 

f. Go to the Elevation view. You will need to go into the Visibility/Graphic Overrides 
and; turn the Mass category on, tick Ghost Surfaces and then for the Mass > Form 
subcategory override the Projection Line colour to white. 

1 2 
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31. Hidden Complex Detail  
You don’t always have to model complex geometry inside of Families to achieve a high 
level of detail at the detailing stage. Try taking an already defined Detail Component and 
nesting it inside of a model Family, such as a Window or a Gutter Profile. 
Then when the user sections through that element, you will be able to display the Detail 
Component rather than the modeled geometry. 
 
If you keep your Family geometry simple and use Detail Components instead, your Family 
and project overall will perform better. 

32. Can’t Place Spot Elevation in Plan  
Having some issues with placing a Spot Elevation on elements (namely Floors) in Plan 
view? Just check that your Visual Style is not set to Wireframe. When it is set to Wireframe, 
Revit is unable to detect the top or bottom of the elements you are trying to Tag. 

Presentation 

33. Sun Path Animation  
A brand new feature in 2012 which is easily overlooked is the ability to preview the solar 
study directly in Revit, without the need to export to an .AVI file. Just make sure that the 
Sun Settings are set to either Single Day or Multi-Day, and Shadows are On. 
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34. Large Animation Render  
Rendering large animations in Revit can be a time consuming process, especially given 
that you cannot hook it into a render farm like you can in 3D Studio Max to help distribute 
the work load. But you can achieve a similar process with a little more manual preparation. 
 
Instead of a single PC rendering the whole animation, why not try rendering a select 
number of frames on each PC. You can see in the image below that the settings are set to 
render frames 1-50. But on a different PC running at the same time, it could be rendering 
frames 51-100, and so on. 
 

 
 
When the renderings have been completed from each of the PCs, you can stitch them all 
together to form a single rendering. Free programs such as Windows Live Movie Maker will 
help to achieve this. http://explore.live.com/windows-live-movie-maker 
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35. Exploded Axonometric Views  
To show an exploded axonometric view. 

a. Duplicate the {3D} view by the number of floor plans in the building, and rename. 

b. For each new 3D view, turn on the Section Box and crop appropriately. 

c. Lock the orientation for each 3D view. 

d. Place each 3D view on a sheet view, and line up using the green alignment lines 
which Revit shows when they are lined up. 

e. Draw hidden line Detail Lines to show them lining up. Note, this is not going to be 
perfectly lined up, but no-one will know. 

f. Pin all views and Detail Lines in place so they don’t accidentally get moved. 
 

 
TIP: If you already have plan views created with the View Range set correctly, you 
can quickly apply those settings to the 3D views by right clicking on the View Cube > 
Orient to View > Floor Plans > …the desired floor plan. This will automatically apply 
the Section Box to the view, and all you need to do is to reorientate the view. 
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36. Easy ‘Soft’ Renders  
Revit won’t give you hand drawn or impressionistic looks to your renders, but there is a 
simple overlaying trick which you can do in most graphics applications which will help. 
I’m using GIMP (www.gimp.org), but the techniques will be similar in other applications. 

a. Render an image in Revit and save it out to a file. 

b. Using the same 3D View, set it to Hidden Line, and using the Application Menu (‘R’) 
> Export > Images and Animations > Image tool to export out an image file. Make 
sure you set a suitably high enough resolution. 
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c. Open both images in the graphics application and copy the image of the Hidden Line 
view to over the top of the render. Some resizing of the Hidden Line image might be 
required to line it up with the Render underneath. 
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d. With the Linework layer selected, what we need to do is make the white areas 
transparent. We do this by using the Transparency tool. 
 

 
 
This then results in being able to see the Render with just the Linework over the top. 
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e. The last thing to do is give the Render an artistic look. Fortunately, these kinds of 
applications have Filters which change the appearance. We now select the Render 
layer and apply a Filter. 
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f. Here are some of the results we can achieve in as little as 5-10mins. 
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Families 

37. Easy Voids  
When you create a Void object it will typically automatically void existing Solid objects 
which it crosses. This can lead to the new Void cutting objects which you might not voided. 
An easy alternative to this is to work with Solids first and then convert it to a Void. 

a. Create the Solid which will eventually be the Void 

b. Select the Solid and from the properties change it to a Void. 

c. Use the Modify > Cut Geometry tool to force the new Void object to cut the Solid 
objects of your choice. 
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38. Nested Families in Arrays  
Arrays in Families can be a fickle beast, and most users will typically create the arrayed 
object as a nested Family as it will produce more consistent results. When the nested 
Family is to be constrained between references so it flexes with the host Family can then 
add extra complexity which once again can prove unpredictable. 
 
To make the nested Family flex with the host Family, rather than trying to constrain (Align & 
Lock) to other references, it’s far easier to pass a parameter value from the host Family into 
an instance parameter in the nested Family. 
Then you Align and Lock the center of the nested Family to a reference in the host Family. 
 

 
 
Don’t constrain the ends to the host model as it will over constrain the nested Family. 

Management 

39. Who Changed What?  
With the improvements to Worksets in the 2012 release, Model/BIM Managers now have 
the ability to see who has made what changes (excluding element deletions) to the model. 
When you activate the Worksharing Display settings, and then hover the cursor over an 
element, a popup will give some Worksharing info including who made the last update to 
the central file for that element.  

Align & Lock  

Don’t Constrain  Don’t Constrain  
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40. Mirrored Elements Audit  
The Revit Model Review add-in is typically an underrated and underused tool. This add-in 
provides a number of useful checks which can be carried out on a model, sometimes in a 
matter of seconds. One of the more useful checks you can do is to check if elements have 
been mirrored. Great for those Windows or Plumbing Fixtures which don’t come as a 
reversed design. 
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For a result which is a little more visually obvious, try putting a line through the element in a 
particular direction. 
 
e.g. For a Window on the exterior face, draw a Model Lines from the bottom-left corner to 
the top-right corner. This line can be controlled via Detail Levels (maybe Coarse), or a Sub-
Category. This immediately lets you know two things; that the exterior of the window is 
facing the exterior of the building, and whether the window has been mirrored. 
 

 
 
It’s quite easy to pick the odd one out. 
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Adaptive Components 

41. The ‘Workplane’ Hack  (Credit: Zach Kron) 
When you need elements such as Dimensions or a Points to traverse parallel to a particular 
plane, it’s usually not sufficient enough to rely on a Reference Line. To overcome these 
kind of limitations you can use the ‘Workplane’ hack. 
 
This technique simply replies on having created a workplane by using either a 2D Form, or 
the surface from a 3D Form. When you are placing the Dimension or Point, you set the 
Workplane to one of these surfaces. 
 

 

  

Surface  

Point  
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Discipline Specific 

Architecture 

42. Site Section – Natural Ground Line  
When you have an existing topo and you need to show the existing ground line in section, it 
will typically show the poche hatch under it. To hide the poche hatch you need to select the 
existing topo and then right click and select Override Graphics in View > By Element. In this 
dialog the natural instinct is to go to Cut Pattern and uncheck Visible. But what you really 
need to do is to uncheck the Visible option for Surface Pattern. 
 
You can then adjust the Cut Lines too to alter its graphical appearance. 
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43. Creating Complex Framing Designs  
Creating a fairly complex Structural Framing shape can be quite a time consuming process 
when you are modeling the elements individually. 
An easier option might be to firstly create a Truss element, which then gives you the ability 
to modify the shape by using the Edit Profile button on the Ribbon, and then using the 
Remove Truss Family button to remove the Truss framework leaving just the Structural 
elements. 
 

 

MEP 

44. Lengths of Pipe / Duct Runs  
Try creating schedules for Pipes and Ducts which report just the Length of those elements. 
You can even Group the elements in the schedule by System Name to give a total run. 
The results aren’t going to be 100% perfect due to not taking into account the Fittings, but it 
should be a good start to getting an estimated cost.  

1. Complex Shapes 
designed with the 
Truss tool 

2. Remove Truss 
framework using 
button on Ribbon 
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45. Equipment Clearances (e.g. PIR Sensor) 
By building in additional Solid geometry to equipment and applying a transparent material, 
you can help simulate clearances. 
Then by using the Interference Check you can check if those clearances are being 
encroached by other geometry in the model. 
 

 


